This documentation, which includes embedded help systems and electronically distributed materials, (hereinafter referred to as the “Documentation”) is for your informational purposes only and is subject to change or withdrawal by CA at any time.

This Documentation may not be copied, transferred, reproduced, disclosed, modified or duplicated, in whole or in part, without the prior written consent of CA. This Documentation is confidential and proprietary information of CA and may not be disclosed by you or used for any purpose other than as may be permitted in (i) a separate agreement between you and CA governing your use of the CA software to which the Documentation relates; or (ii) a separate confidentiality agreement between you and CA.

Notwithstanding the foregoing, if you are a licensed user of the software product(s) addressed in the Documentation, you may print or otherwise make available a reasonable number of copies of the Documentation for internal use by you and your employees in connection with that software, provided that all CA copyright notices and legends are affixed to each reproduced copy.

The right to print or otherwise make available copies of the Documentation is limited to the period during which the applicable license for such software remains in full force and effect. Should the license terminate for any reason, it is your responsibility to certify in writing to CA that all copies and partial copies of the Documentation have been returned to CA or destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CA PROVIDES THIS DOCUMENTATION “AS IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL CA BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT, FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF CA IS EXPRESSLY ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.

The use of any software product referenced in the Documentation is governed by the applicable license agreement and such license agreement is not modified in any way by the terms of this notice.

The manufacturer of this Documentation is CA.

Provided with “Restricted Rights.” Use, duplication or disclosure by the United States Government is subject to the restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)(3), as applicable, or their successors.

Copyright © 2011 CA. All rights reserved. All trademarks, trade names, service marks, and logos referenced herein belong to their respective companies.
Contact CA Technologies

Contact CA Support

For your convenience, CA Technologies provides one site where you can access the information you need for your Home Office, Small Business, and Enterprise CA Technologies products. At http://ca.com/support, you can access the following:

- Online and telephone contact information for technical assistance and customer services
- Information about user communities and forums
- Product and documentation downloads
- CA Support policies and guidelines
- Other helpful resources appropriate for your product

Providing Feedback About Product Documentation

If you have comments or questions about CA Technologies product documentation, you can send a message to techpubs@ca.com.

If you would like to provide feedback about CA Technologies product documentation, complete our short customer survey, which is available on the CA Support website at http://ca.com/docs.
Appendix A: Access Rights

Timesheets Access Rights

Dashboard Access Rights

Page Access Rights
Chapter 1: About Personalizing CA Clarity PPM

This section contains the following topics:

What You Can Personalize (see page 7)

What You Can Personalize

Personalize pages, lists, charts, filters, and personal dashboards. The changes you make are visible only to you.

If you have the privileges to personalize, the related menus or icons appear on a page or a portlet toolbar. If the owner changes and publishes the original item, you lose your personal changes.

The content in this guide is based on the out-of-the-box version of CA Clarity PPM. Suppose, you or your CA Clarity PPM administrator creates any user-defined values and fields, or configures a page or portlet. The procedures for that page or feature in the guide can be different.

What You Can Personalize

To personalize a page, you can:

- Add a portlet
- Add a new tab and tab content to tabbed pages
- Edit tab details
- Reorder tabs
- Delete a tab

To personalize a dashboard, you can:

- Add or remove portlets
- Add or remove page filters
- Change the layout of dashboard portlets
You can configure lists, charts, and filter portlets that appear on pages, tabs, or dashboards in CA Clarity PPM. To configure a list, you can:

- Set the layout of columns
- Set options that determine how the list appears
- Edit the fields
- Add a Gantt chart, an image, a progress bar, or a time-scaled value
- Add an aggregation row

To configure a chart, you can:

- Change the chart type
- Change the source data
- Change the options that determine how the chart displays

To configure a filter portlet, you can:

- Add a field
- Add a lookup or a multi-valued lookup
- Decide field layout
Chapter 2: Timesheets

This section contains the following topics:

Configure Your Timesheet (see page 9)

Configure Your Timesheet

You can configure your timesheet to display only the columns that you want to see. Select the sorting method for the timesheet and set other timesheet options.

Follow these steps:

1. Open the timesheet to configure.
   The timesheet page appears.
2. Click the Configure link.
   The configure timesheet page appears.
3. In the Content and Layout section, select a column labels to display on the timesheet from the Available Columns list. Then, move them to the Selected Columns list.
4. Specify the following sorting options:
   
   **Default Sorting Column**
   
   Specifies the column to sort the tasks on the timesheet page.
   
   **Values:**
   
   - Investment. The name of the project that includes the task.
   - Description. The task description.

   **Sorting Order**
   
   Specifies the order of sorting the column.
   
   **Values:**
   
   - Ascending. Sorts the column from lowest value to highest.
   - Descending. Sorts the column from highest value to lowest.
5. In the Time Entry Options section, complete the following fields:

**Auto-Populate**

Automatically populates all subsequent timesheets according to the rule set.

**Values:**

- Off. Do not auto-populate timesheets.
- Copy time entries from the previous timesheet. Populates new timesheets with the task entries from the current timesheet.
- Copy time entries from the previous timesheet and include actuals (actuals not copied for incidents). Populates new timesheets with the task entries and daily actuals from the current timesheet. Actuals for one-time time entries, such as vacation or sick time, are not copied.

**Display Unit**

Indicates the measure of time entries by hours or days.

**Decimal Place**

Indicates the number of decimal places for the time entry display unit selected.

6. Save the changes.
Chapter 3: Personal Dashboards

This section contains the following topics:

About Dashboards (see page 11)
By Example: Dashboards (see page 13)
How to Set Up a Dashboard (see page 14)
Personalize a Shared Dashboard (see page 21)

About Dashboards

Create portlets that show the information you want to see and place the portlets on your personal dashboard for viewing. The portlets can display information in graphical chart format or list format.

You can create as many dashboards and portlets as you need. If you have more portlets than you want to show on one page, you can create a tabbed dashboard for additional pages.

Exporting Dashboard Information to Other Formats

You can export the contents of a dashboard or a portlet displayed in the dashboard to Microsoft Excel or PowerPoint. You can fit the exported data to a page, especially when you export information to PowerPoint for a presentation. Also, place each exported portlet on a separate page, rather than fitting all portlets onto a single page as they appear in a dashboard.

See the CA Clarity Basics User Guide for more information.

Dashboard Sharing

When you create a dashboard, you are given the ability to view and manage the dashboard. You can share the dashboard with other users, groups, or OBS groups in your organization. If you share your dashboard with another user, the dashboard also appears in the shared user personal dashboard list for viewing.

Two options are available for sharing:

- View. This option allows a user to view the dashboard.
- Manager. If you are the creator of a dashboard, you are automatically assigned as the manager. When you give another user this ability, the user can view and change the dashboard properties and publish the changes to all shared versions. Give the permission to only a few trusted users.
Personalized Dashboards

You can also allow a user to change the shared copy of the dashboard that appears in the user dashboard list. The changes apply only to the user version and other users cannot view them. The changes remain in the user copy until the owner of the dashboard, or a user with manager rights publishes changes. The latter overwrites all personalized changes.

Access Rights to Use Dashboards

CA Clarity PPM administrator assigns the access rights to work with dashboards. The following access rights let you work with dashboards and portlets:

- Dashboard - Create
- Dashboard - Navigate
- Portlet - Create
- Portlet - Navigate

The access rights are global. The navigate rights provide access to the Dashboards and Portlets links in the Personal menu. The create rights allow you to create a dashboard or portlet.

In addition to the rights to create and use a dashboard, you require to have access rights to the information displayed on a dashboard. Access to a dashboard does not automatically include access to the project information. If you share a dashboard, the user with whom you share, also requires the right to see the shared information.

Note: Sharing a dashboard with a user does not automatically ensure that the user can see the dashboard. The user must have the Dashboard - Navigate access right so that the Dashboard option appears in the Personal menu. The Dashboard - Navigate access right is assigned separately.

If you have the appropriate access rights for stock CA Clarity PPM system portlets, select and use the portlets for your dashboards.

Dashboard and Portlet Page Comparison

The following table shows how a dashboard and a portlet page compare in terms of CA Clarity PPM functionality.

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Dashboard</th>
<th>Portlet Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exported Output</td>
<td>Fit to page</td>
<td>Fit to page</td>
</tr>
<tr>
<td></td>
<td>One portlet per slide or sheet</td>
<td></td>
</tr>
</tbody>
</table>
By Example: Dashboards

The following scenarios show how team members and a team manager can use a dashboard.

Team Member 1: Karen

Karen, a team member who is responsible for tracking project management information for multiple projects, creates a dashboard with tabs. From the details page of the new dashboard, she creates the portlets that will show the dashboard data. The portlets she creates include:

- Project Risks
- Budget
- Resource Allocation
- Milestones

She configures her dashboard by determining which portlets to present on each tab. Then, Karen adjusts the layout of portlets on each tab by dragging and dropping the portlets into position on the tab layout section. She adds a filter for the dashboard that gives her the ability to filter information for all of the portlets at the same time. When the dashboard is complete, she views the dashboard, filters for the information that she wants, and exports a copy to PowerPoint as a test.

Before each weekly team meeting, she views the dashboard to monitor each project that she tracks and exports the results to PowerPoint. The team leader includes the PowerPoint slides in the regular team meeting agenda.

---

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Dashboard</th>
<th>Portlet Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sharing with specific users</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Page type</td>
<td>Page with tabs</td>
<td>Page with tabs</td>
</tr>
<tr>
<td></td>
<td>Page without tabs</td>
<td>Page without tabs</td>
</tr>
<tr>
<td>Portlet layout</td>
<td>2-column templates</td>
<td>2-column templates</td>
</tr>
<tr>
<td></td>
<td>3-column templates</td>
<td>3-column templates</td>
</tr>
<tr>
<td></td>
<td>Row layout</td>
<td></td>
</tr>
</tbody>
</table>

---
Team Member 2: Roberto

Roberto, a team member who does not have the right to create dashboards, navigates to Dashboards. Roberto can see two dashboards that his team manager shares with him: Security Development Team and Weekly Time Entries. Roberto views the Security Development Team dashboard. Also sees that he has five assigned tasks and three bugs. He clicks on the first task to get more details and starts working on the task.

Team Manager: Stan

Stan, the team manager creates a dashboard with two tabs: Team Work and Team Status. He populates the tabs with portlets created beforehand and with stock CA Clarity PPM portlets to which he has access. Stan adds the following portlets:

- Team Members
- Bugs and Issues by Components
- Tasks by Team Member
- Time Entries by Team member
- Work Completed and Work Remaining

Stan does not allow others to personalize his dashboard. He does share the dashboard with the entire OBS development unit and the executive management team to view portlets in the dashboard.

How to Set Up a Dashboard

Before you set up a dashboard, consider the following:

- The number of portlets you plan to include.
  
  Helps determine if you require tabbed pages.

- How the portlets present information.
  
  You can plan for the visual presentation of graphs or the statistical presentation that is possible with rows and columns.

- The users with whom you can share.
  
  Some users do not have rights to the information you are presenting in portlets. In addition, consider individuals to whom you can give manager privileges for your dashboard.
Follow these steps:

1. Create the dashboard (see page 15).
2. Configure the dashboard by adding portlets and laying out the portlets on the dashboard:
   - Dashboard without tabs (see page 17)
   - Tabbed dashboard (see page 18)
3. Share the dashboard (see page 20).

**Create a Dashboard**

Follow these steps:

1. Open Home, and from Personal, click Dashboards.
   The dashboards list page appears.
2. Click New.
   The create page appears.
3. Complete the following fields:
   - **Dashboard Name**
     Defines the name of the dashboard. The name appears on the title bar of the dashboard and in the list page for dashboards.
   - **Dashboard ID**
     Defines a unique alphanumeric identifier for the dashboard.
   - **Description**
     Defines the purpose of the dashboard and provides any relevant information.
   - **Type**
     Specifies if the dashboard is a single page or tabbed pages.
   - **Personalizable**
     Specifies if the users with whom you share a dashboard can change the copy that appears in their dashboards list. Personal changes to a dashboard are local to the user who makes them. The changes are overwritten when the owner of the dashboard, or a user with administrator privileges publish new changes.
4. Save the changes.
Dashboard Layout

Open the dashboard details page to complete the dashboard layout. From the details page, you can:

- Add portlets that you create and stock CA Clarity PPM portlets to which you have access.
- Create new portlets.
- Select a layout template.
- Drag and drop portlets into the appropriate positions.
- View the dashboard.
- Export dashboard information.
- Share the dashboard.

To view the details page, open Home, and from Personal, click Dashboards, then click the name of the dashboard in the list that appears.

The following illustration shows the details page for a dashboard that has two tabs. In the Contents and Layout section, the Requirements tab is highlighted on the left and the portlets added to the tab show on the right. The toolbars for working with tabs and portlets are shown below the work areas. Mouse-over an icon in the toolbar to display its purpose.
Dashboard Layout Templates

To lay out a dashboard, select a template layout that determines the number of portlets appearing in a row and the percentage width for each portlet position. You can then add portlets and drag them to the position in the Content and Layout section.

A layout template provides a guideline for your displayed dashboard. If a portlet is large (a grid portlet with many columns), it can exceed the space allotted to it in a row. In this case, the portlet is not truncated. But a larger size is accommodated by moving portlets to another row when the dashboard displays. Hence, a displayed dashboard does not look exactly the way you design it in the Content and Layout section.

The following list shows the available templates available for dashboards.

- 50-50 percent
  ![50-50 template]

- 66-34 percent
  ![66-34 template]

- 25-50-25 percent
  ![25-50-25 template]

- 33-33-33 percent
  ![33-33-33 template]

Configure a Dashboard Without Tabs

This procedure explains how to add portlets to a dashboard. The procedure assumes the dashboard and portlets are already created.

Follow these steps:

1. Open the details page for the dashboard.
2. In the Content and Layout section, click the Add Portlet icon.
   A list page of available portlets appears.
3. Select the check box for each portlet and click Add.
   The details page appears with the portlet icons showing in the work area of the Content and Layout section.
4. Select the layout template.
   You can mouse-over each template in the list for the column format it represents. The template you select determines how many columns appear on the dashboard and the percentage of the dashboard allotted to each column.

5. Arrange the portlets in the order you want by dragging and dropping.

6. Save your changes.

**Configure a Dashboard with Tabs**

This procedure explains how to add tabs and portlets to a dashboard. The procedure assumes the dashboard and portlets are already created.

**Note:** When creating a dashboard, ensure that you designate the Type as *Page with Tabs* to add tabs to the dashboard. If the option is not selected, you cannot add a tab.

Use the Tabs: Content and Layout section to manage the tabs for the dashboard. The following list describes the purpose of the icons used in this section:

- **+**
  Adds a new tab to the tab list in the content pane or adds an existing portlet to the tab in the layout pane.

- **-**
  Removes a tab from the dashboard.

- **Paintbrush**
  Opens a tab for editing.

- **Up arrow**
  Moves a tab up in the dashboard presentation.

- **Down arrow**
  Moves a tab down in the dashboard presentation.

- **Star**
  Opens a page to create a portlet.

**Add a Tab to a Dashboard**

**Follow these steps:**

1. With the details page for the dashboard open, click the Add Tab icon in the Content and Layout section.
   The create page appears.
2. Complete the following fields:

   **Tab Name**
   Defines the name for the tab that appears on the dashboard.

   **Tab ID**
   Defines a unique alphanumeric identifier for the tab.

   **Description**
   Defines the purpose of the tab and provides any relevant information.

   **Personalizable**
   Specifies if a user who can view the dashboard can personalize the tab. The changes are local to the user who makes them.

3. Save your changes.

### Add a Portlet to a Dashboard

Follow these steps:

1. With the details page for the dashboard open, highlight the tab in the Contents and Layout section to configure.
   The right pane in the Content and Layout section changes to display any existing configuration for the tab.

2. Click the Add Portlet icon in the Content and Layout section.
   A list page of available portlets appears.

3. Select the check box for each portlet to add to the dashboard, and click Add.
   The details page appears with the portlet icons for the tab showing in the layout area.

4. Select the layout template.
   You can mouse-over each template in the list for the column format it represents.
   The template you select determines how many columns appear on the dashboard and the percentage of the dashboard allotted to each column.

5. Drag and drop the portlet icons into the position on the tab.

6. Save your changes.

7. Complete the preceding steps for each tab to configure.
Share a Dashboard

You can share a dashboard with a user, a group of users, or an OBS group. When you share, the dashboard appears in the user list of dashboards for viewing. By default, when you share, the user you share with has view only rights.

You can also assign manager rights to a user. The rights let the user change and publish the dashboard to all who can view the dashboard.

Share a Dashboard

**Follow these steps:**

1. On the dashboard details page, open Actions, and click Sharing.
2. Click the appropriate menu to add a resource, group, or OBS unit. Click Full View to see the names of users who have access to the dashboard through means other than sharing.
3. Click Add.
4. Select check boxes next to those individuals, groups, and OBS groups with whom you want to share, and click Add.

Assign Manager Rights to a User

**Follow these steps:**

1. On the Resources page, locate the user to assign manager rights for your dashboard.
2. In the Access Right column, select Manager from the drop-down.
3. Save the changes.

Publish a Dashboard

A dashboard manager can publish changes to a dashboard. When a dashboard manager publishes, the new changes affect every user who can view the dashboard. If a user personalizes the dashboard, the changes are overwritten by the new changes being published.

**Follow these steps:**

1. Open Home, and from Personal, click Dashboards. The dashboards list page appears showing your dashboards.
2. Click the name of the dashboard to change and publish. The dashboard details page appears.
3. Change the dashboard, if required, and click Save.
4. Click Publish, and then click Yes to publish.

**Edit a Portlet in a Dashboard**

**Follow these steps:**
1. Open Home, and from Personal, click Dashboards.
2. Select the dashboard from the list that appears.
   The details page for the dashboard appears.
3. In the Content and Layout section, place your cursor on the portlet, and click Edit.
   The properties page appears.
4. Edit the portlet and save the changes.

**Remove a Portlet from a Dashboard**

Removing a portlet from a dashboard, does not delete it but remains in your portlets list page. To delete the portlet permanently, delete it from the portlets list page.

**Follow these steps:**
1. Open Home, and from Personal, click Dashboards.
2. Select the dashboard from the list that appears.
   The details page for the dashboard appears.
3. In the Content and Layout section, right-click the portlet, and click Remove.
4. Save the changes.

**Personalize a Shared Dashboard**

You can personalize another user dashboard when shared with you. The changes that you make are visible only to you and not to other users who view the dashboard on their computers. If the creator of the dashboard modifies and publishes the dashboard, your personal changes are lost.
You can personalize the following:

- Dashboard name and description.
- Dashboard content. You can add and remove portlets.
- Page filters for the portlets.
- Portlet layout.

**Follow these steps:**

1. Open Home, and from Personal, click Dashboards.
   
   The dashboards list page appears.

2. Select a dashboard from the list.
   
   The dashboard displays for viewing.

3. Open the Actions menu, and from View Dashboard, click Personalize.
   
   The content page appears.

4. Select the appropriate menu and modify the dashboard.

5. Save the changes.
Chapter 4: Personalizing Pages

This section contains the following topics:

How to Personalize a Page (see page 23)
How to Manage Page Tabs (see page 25)

How to Personalize a Page

For pages that can be personalized, click the view option from the Actions menu, and click the Personalize icon.

To personalize a page, you can:

- Manage portlets (see page 23)
- Add a filter (see page 24)
- Change the layout of portlets on the page (see page 24)
- Manage page tabs (see page 25)

Manage Portlets on a Page

You can add portlets, remove portlets, or restore default portlets.

Add a Portlet

Follow these steps:
1. On the page, click File and select Personalize.
   The content page appears.
2. Click Add.
   The content selection page appears.
3. Select the portlets to add, and click Add.

Remove a Portlet

Follow these steps:
1. On the page, click File and select Personalize.
   The content page appears.
2. Select the portlets to remove and click Remove.
How to Personalize a Page

**Restore the Default Portlets**

**Follow these steps:**

1. On the page, click File and select Personalize.
   
   The content page appears.

2. Click Restore Defaults.

**Add a Filter to a Page**

**Follow these steps:**

1. On the page, click File and select Personalize.
   
   The personalize content page appears.

2. Click Page Filters.
   
   The filter content page appears.

3. Click Add.

4. Select the check box next to the filter, and click Add.
   
   The filter is added to the list of page filters for the page.

5. Save the changes.

**Reorder Portlet Layout**

**Follow these steps:**

1. On the page, click File and select Personalize.
   
   The personalize content page appears.

2. Click Layout.
   
   The layout page appears.

3. In the Layout field, select the layout template for the portlets.
   
   Each option provides the number of columns and the percentage of the page given to each column. In the Row Layout option, the number of portlets you place in a row determines the percentage of space given to a portlet.

4. In the boxes that represent columns on the page, use the arrow keys to move the portlets in the order you want for the page.

5. Save the changes.
How to Manage Page Tabs

You can create your personalized workspace by managing the tabs that appear on a page and the portlets that appear on each tab.

The option to manage a page tab, appears on the File menu. The name that you see on the option can vary according to the page on which the option is located. For example, on the Overview page, the option is named Manage My Tabs, but if you open a project and look for the option on the File menu, it is named Manage Project Tabs.

Use the manage tabs page to:

- Add new tabs and select the portlets for these tabs (see page 25).
- Remove a tab (see page 27).
- Reorder the display of the tab on the Overview page (see page 27).
- Edit the details for a tab (see page 26).

Add a New Tab and Tab Content

Add a new tab to a page, and then add the portlets you want displayed on the page. New tabs that you add appear next as the last tab on the page.

Follow these steps:

1. On the page, click the icon to manage tabs.

   **Note:** The option name can vary depending on the page. On the Overview page the option is named Manage My Tabs. But for a project page, the option is named Manage Project Tabs.

   The manage tabs page appears.

2. Click New.

   The properties page appears.

3. Complete the following fields:

   **Tab Name**

   Defines the name of the tab. The name appears on the tab in CA Clarity PPM.

   **Tab ID**

   Defines a unique alphanumeric identifier for the tab.
How to Manage Page Tabs

Content Source
Specifications where the data that appears in a portlet or portlet page originates.

Default: Customer
Required: Yes

Description
Defines the description of the tab.

Layout
Specifications how portlets added to a page or a tab are placed. The number of
columns indicates how many portlets can be placed on a row and indicates the
percentage of the page given to each portlet on the row. The Row layout can
have the one to three portlets in a row with equal space provided for each
portlet.

Personalizable
Specifications if an end user can make personal changes to a page or a tab that only
the end user can view.

4. Click Save and Continue.
The content page appears.

5. Click Add.

6. Select the portlets you want to appear on the new tab, and click Add.
The content page appears.

7. Save the changes.

Edit Tab Details

You cannot edit the properties of all tabs. If the tab can be edited, it shows a link when
you mouse-over the list. You can edit the properties of custom tabs you create.

Follow these steps:
1. On the page, click the Manage Project Tabs icon.

   Note: The option name can vary depending on the page. On the Overview page, the
   option is named Manage My Tabs. But on a project page, the option is named
   Manage Project Tabs.

   The manage tabs page appears.

2. Click the name of the tab to edit.
   The properties page appears for the tab.

3. Click the Content and Layout links to edit the tab details.
Reorder Tabs

Follow these steps:
1. On the page, click the icon to manage tabs.
   
   Note: The option name can vary depending on the page. On the Overview page the option is named Manage My Tabs. But for a project page, the option is named Manage Project Tabs.

2. Click Reorder.
   
   The reorder tabs page appears.

3. Select the tab and click the Move Up or Move Down arrow to change the order.

4. Save the changes and continue.

Delete a Tab

You can remove the tabs that you create on a page. You cannot remove the CA Clarity PPM default tabs, or the tabs installed with the PMO Accelerator add-in.

Follow these steps:
1. On the page, click the icon to manage tabs.
   
   Note: The option name can vary depending on the page. On the Overview page the option is named Manage My Tabs. But for a project page, the option is named Manage Project Tabs.

2. Select the check box next to the tabs, and click Delete.
Chapter 5: Configuring Lists, Charts, and Filters

This section contains the following topics:

- Open the Configuration Options (see page 29)
- How to Configure a List (see page 29)
- How to Configure a Chart (see page 45)
- How to Configure a Filter Portlet (see page 52)

Open the Configuration Options

Open the Options menu by clicking the Options icon that appears on the portlet toolbar, and click Configure.

How to Configure a List

You can complete the following tasks to personalize a list portlet:

- Open the configuration options (see page 29)
- Set the layout of columns (see page 30)
- Set list options that determine how the list displays (see page 30)
- View and edit fields for the list (see page 38)
- Add a Gantt chart (see page 31)
- Configure Gantt chart display settings (see page 33)
- Modify time period settings for a Gantt chart (see page 37)
- Add an image (see page 38)
- Add a progress bar (see page 39)
- Add a time-scaled value column (see page 40)
- Add an aggregation row (see page 43)
- Display an aggregation field as a bar or column graph (see page 44)
Set List Column Layout

Follow these steps:

1. Open the Options menu and click Configure.
   The configuration window appears with the list column layout displayed.

2. In the Column Layout section, select columns to include in the portlet by highlighting the columns in the Available Columns list and clicking the right arrow to add them to the Selected Columns list.
   You can use the up and down arrows to place the selected columns in the desired order.

3. Complete the following actions in the Column Sorting section:
   a. Select the order in which columns are sorted by selecting the appropriate field in each column drop-down list.
   b. Click Ascending or Descending to determine how data is sorted within each column.

   Note: Column sorting is not available for hierarchical list pages.

4. Save the changes.

Set List Options

Follow these steps:

1. Open the Options menu and click Configure.
   The configuration window appears with the list column layout displayed.

2. Open the List Column Section menu, and click Options

3. Complete the following fields:

   Secondary Value Display

   Indicates the way that secondary values display in a grid cell.

   Values:
   - Mouseover only. Specifies no secondary value display.
   - Mouseover and redline. Specifies the display of a secondary value when a user places the pointer over a cell in a grid. This helps to compare values. For example, if you have a column named Cost and another column named Baseline Cost, you might want to display both values in one cell. To show both, you can select Baseline Cost as the secondary value. The Cost value displays as usual; however, when a user moves the pointer over a cell in the grid, the Baseline Cost also displays.
Show Null Secondary Values. Specifies that the secondary value displays even when there is no number value to show.

**Rows per Page**
Specifies the number of rows per page to display.

**Filter**
Indicates how the results appear initially.

**Values:**
- Automatically show results. Indicates you want immediate results.
- Do not show results until I filter. Indicates you want results provided after you filter.

**Default:** Automatically show results

**Highlight Row by Attribute**
Specifies the attribute whose row is highlighted when the attribute's value is not zero.

**Display Currency Code in Column**
For money attributes, the currency code is shown in the column. This applies only when a single currency is being used. Select the check box to display the currency code.

**Allow Configuration**
Indicates that a user can make changes to the appearance of a portlet. Select the check box to allow configuration.

**Allow Label Configuration**
Indicates that a user can make changes to portlet labels. Select the check box to allow configuration.

4. Save the changes.

---

**Add a Gantt Chart to a List Portlet**

A Gantt chart is a virtual field that shows duration and progress over time. New virtual fields are automatically displayed in the far right column of the list. You can move the field to a different position in the List Column layout.

**Follow these steps:**

1. Open the List Column Section menu, and click Fields.
   The list column fields page appears.
2. Click New.
   The create page appears.

3. Select Gantt, and click Save and Continue.
   The column settings page appears.

4. Complete the following fields in the General section:
   
   **Column Label**
   Defines the name that appears at the top of the list column.

   **Show Column Label**
   Indicates whether the column label appears at the top of the column list. Select the check box to have the column label appear.

   **Allow Word Wrapping in Column Header**
   Indicates whether the text in the column label can wrap within the column. Select the check box to allow wrapping.

5. Complete the following fields in the Time Scale section:
   
   **Start Date**
   Indicates the start date for the Gantt chart. Do one of the following:
   
   ■ Select Specific Date and enter a date or click the Datepicker icon and select a date from the calendar that appears.
   ■ Select Rolling Date and select a relative date from the drop-down list.

   **Time Scale**
   Specifies the time values to show across the top of the Gantt chart. Select a value from the drop-down list.

   **Number of Time Periods**
   Indicates the number of time periods to be displayed.

   **Time Period Offset**
   Defines the number of time periods you want to shift the beginning of the Gantt bar relative to the Start Date. You must enter a Start Date value to use this option.

   **Show Group Row Header**
   Indicates whether to print the time scale value used. Select the check box to show the value and select the value to be shown from the drop-down list.

6. Complete the following fields in the Primary Bar section:
   
   **Item Name Attribute**
   Specifies the field name for the primary bar of the Gantt chart. Select a field from the drop-down list.
Start Date Attribute

Specifies the date field value to use at the beginning of the Gantt bar. Select a field from the drop-down list.

Finish Date Attribute

Specifies the date field value to use at the end of the Gantt bar. Select a field from the drop-down list.

Milestone Attribute

Specifies the field value to use as a milestone. Select a field from the drop-down list. If the field contains a non-zero value, the Gantt chart displays a diamond.

Progress Through Date Attribute

Specifies the date field value to use to indicate when work is complete. Select a field from the drop-down list. If you choose a Progress Through Date Attribute value, the value chosen overrides the Progress Percent Attribute.

Show Mouseover

Indicates the values that appear when a user moves a cursor over the bar. Select the check boxes of the items listed that you want to appear.

7. In the Show Dates on Primary Bar section, select the dates you want to show on the primary Gantt bar in the Available list and click the right arrow key to move the dates to the Selected list.

8. (Optional) To display a second bar below the primary bar for comparison purposes, select the Show Secondary Bar check box and complete the fields in the section.

9. Save the changes.

Configure Gantt Chart Display Settings

Gantt charts appear on various pages throughout CA Clarity PPM. The steps to change the display settings are the same from any page with a Gantt chart.

By default, Gantt charts display only one bar, the primary bar. You can change the information displayed in that bar (Total Effort, by default). You can also add a secondary bar to display complimentary or contrasting data. You can also change the time configurations that display in the chart.

Follow these steps:

1. From a page that contains a Gantt chart, open the Options menu and click Configure.

The list column layout page appears.
How to Configure a List

2. Open the List Column Section menu, and click Fields.
   The list column fields page appears.

3. Click the Properties icon next to the Gantt chart column label (for example, the Gantt chart column label can be "Schedule").
   The Gantt chart column settings page appears.

4. Change the following field in the General section:
   
   **Column Label**
   - Defines the name for the main column header, which spans multiple columns.
     - **Default:** Schedule
   
   **Show Column Label**
   - Indicates if the name of the column displays on the page or portlet.
     - **Default:** Selected
   
   **Allow Word Wrapping in Column Header**
   - Indicates if you want text in the column label to wrap.
     - **Default:** Cleared

5. Change the following fields in the Time Scale section:

   **Start Date**
   - Indicates the start date for the column spread.
   - **Values:** Specific Date or Rolling Date
   - **Default:** (Rolling Date) Start of Current Week

   **Time Scale**
   - Specifies the time period by which data displays.
   - **Values:** Year, Quarter, Month, Week, Day
   - **Default:** Week

   **Number of Time Periods**
   - Defines the number of time periods you want to see displayed.
   - **Default:** 12

   **Time Period Offset**
   - Shifts the beginning of the Gantt bar relative to the Start Date. Enter a positive or negative number of time periods into the field. Enter a Start Date first.
**Show Group Header Row**

Indicates if the timescale displays above the Gantt bar. If you select this option, be sure that you also select a value.

*Values:* Year, Quarter, Month, or Week

*Default:* Cleared

6. Change the following fields in the Primary Bar section:

**Item Name Attribute**

Specifies the type of information to display in the corresponding bar.

*Default:* Task

*Required:* Yes

**Start Date Attribute**

Defines the start date of the corresponding bar display.

*Required:* Yes

**Finish Date Attribute**

Defines the finish date of the corresponding bar display.

*Default:* Finish

*Required:* Yes

**Milestone Attribute**

Specifies the attribute to designate a milestone. You can only assign a milestone attribute for a task.

*Default:* Milestone

*Required:* Yes

**Progress Through Date Attribute**

Specifies the attribute used to move the green progress line relative to the length of the task bar to indicate the work completed for the task.

**Progress Percent Attribute**

Defines the percentage used to move the green progress line relative to the length of the taskbar to indicate the completed task work. If you select a value for this field, it overrides the Progress Through Date Attribute selection.

*Default:* % Complete

**Label for Bar**

Specifies the label text to display above each taskbar.
Additional Information Attribute

Specifies the field used in the text note when you mouse over a taskbar.

Example:

To display the assigned resources for a task when the cursor is over a taskbar, select Assigned Resources from the field. Then, select the Additional Information checkbox in the Show Mouseover field.

Show Mouseover

Specifies the information you want to display in a text note when the mouse scrolls over an area of the Gantt chart.

Values: Item Name, Start Date, Finish Date, Progress Through Date, Progress Percent, Additional Information

Default: Item Name (Selected), Start Date (Selected), Finish Date (Selected), Progress Through Date (Cleared), Progress Percent (Selected), Additional Information (Cleared)

7. Indicate the dates to show in the primary bar when you select the desired dates in the Available section. Click the right arrow to add the dates to the Selected section. You can reorder the dates in the list.

8. Change the following Secondary Bar settings for the Gantt chart to display a secondary bar:

Show Secondary Bar

Indicates if the chart displays a second bar below the primary bar.

Item Name Attribute

Specifies the type of information to display in the corresponding bar.

Default: Task

Required: Yes

Start Date Attribute

Defines the start date of the corresponding bar display.

Required: Yes

Finish Date Attribute

Defines the finish date of the corresponding bar display.

Default: Finish

Required: Yes

Progress Through Date Attribute

Specifies the attribute used to move the green progress line relative to the length of the task bar to indicate the work completed for the task.
**Progress Percent Attribute**

Defines the percentage used to move the green progress line relative to the length of the taskbar to indicate the completed task work. If you select a value for this field, it overrides the Progress Through Date Attribute selection.

**Default:** % Complete

**Show Mouseover**

Specifies the information you want to display in a text note when the mouse scrolls over an area of the Gantt chart.

**Values:** Item Name, Start Date, Finish Date, Progress Through Date, Progress Percent, Additional Information

**Default:** Item Name (Selected), Start Date (Selected), Finish Date (Selected), Progress Through Date (Cleared), Progress Percent (Selected), Additional Information (Cleared)

9. Save the changes.

**Modify Time Period Settings for a Gantt Chart**

You can change the Gantt chart timescale to zoom in and out of the timeline. For example, if you are viewing the monthly timeline, to zoom in to see daily timeline information, select the Days timescale value from the Calendar drop-down at the top of the Gantt chart.

**Follow these steps:**

1. From a page that contains the Gantt chart, open the Options menu and click Gantt.

   The time period settings page appears.

2. Modify the following fields:

   **Start Date**
   
   Indicates the start date for the column spread.
   
   **Values:** Specific Date or Rolling Date
   
   **Default:** (Rolling Date) Start of Current Week

   **Time Scale**
   
   Specifies the time period by which data displays.
   
   **Values:** Year, Quarter, Month, Week, Day
   
   **Default:** Week
Number of Time Periods

Defines the number of time periods you want to see displayed.

**Default:** 12

Time Period Offset

Shifts the beginning of the Gantt bar relative to the Start Date. Enter a positive or negative number of time periods into the field. Enter a Start Date first.

3. Save the changes and close.

View and Edit List Portlet Fields

You can view and edit the fields that display for a list portlet.

**Follow these steps:**

1. Open the List Column Section, and click Fields.
   
   The list column fields page appears.

2. Use the Show and Display fields to control what you see in the list by selecting columns, or a combination of both, select the correct option, and click Go.

3. To make changes to how a field displays, click the Properties icon located next to the field.

4. To change a field label, enter a new value in the Column Label field.

5. Save the changes.

Add an Image to a List Portlet

You can add an image that links to another page. New virtual attributes like an image are automatically displayed in the far right column of the list. You can move the virtual attribute to a different position in the List Column layout.

**Follow these steps:**

1. Open the List Column Section menu, and click Fields.
   
   The list column fields page appears.

2. Click New.
   
   The create page appears.

3. Select Image, and click Save and Continue.
   
   The column settings page appears.
4. Complete the following fields in the General section:

**Column Label**
Defines the name that appears at the top of the list column.

**Show Column Label**
Indicates whether the column label appears at the top of the column list. Select the check box to have the column label appear.

**Allow Word Wrapping in Column Header**
Indicates whether the text in the column label can wrap within the column. Select the check box to allow wrapping.

**Image**
Specifies the image to use in the grid column. Select an image from the drop-down list.

**Link**
Specifies a page link that appears as a secondary value that the user can select.

**Open as Pop-up**
Indicates whether the page appears as a pop-up. Select the check box to have the page appear as a pop-up.

5. Save the changes.

**Add a Progress Bar to a List Portlet**

A progress bar shows progress over time. New virtual attributes like the progress bar are automatically displayed in the far right column of the list. You can move the virtual attribute to a different position in the List Column layout.

**Follow these steps:**

1. Open the List Column Section menu, and click Fields.
   The list column fields page appears.

2. Click New.
   The create page appears.

3. Select Progress Bar, and click Save and Continue.
   The column settings page appears.

4. Complete the following fields in the General section:

**Column Label**
Defines the name that appears at the top of the list column.
Show Column Label
Indicates whether the column label appears at the top of the column list. Select the check box to have the column label appear.

Allow Word Wrapping in Column Header
Indicates whether the text in the column label can wrap within the column. Select the check box to allow wrapping.

Current Stage Name
Specifies the field value to use for each stage in the progress bar. The value displays below the column label.

Current Stage Number
Specifies the field value to use for the current stage in the progress bar.

Number of Stages
Specifies the field value that defines the total number of stages in the progress bar.

Color Attribute
Specifies the color.

Show Label
Determines whether the name of the current stage is displayed in the progress bar. Select the check box to display the name.

Column Width
Defines the percentage of the grid portlet that the virtual column is to occupy.

5. Save the changes.

Add a Time-Scaled Value to a List Portlet
A time-scaled value field is one that you can set up on a list portlet that shows a value for a specific period of time. A time-scaled value is based on a time-varying attribute for which a user enters values in CA Clarity PPM. As a user you cannot create a time-varying attribute. Only an administrator with the appropriate rights can create a time-varying attribute.

You can display multiple time-scaled values in a list portlet. The data for the attributes displays as stacked on the page, with the information for each time-scaled value appearing in the same virtual column. The data that displays can be in units of money, numbers, or percentages.
New virtual attributes such as a time-scaled value are automatically displayed in the far right column of the list. You can move the virtual attribute to a different position in the List Column layout.

**Follow these steps:**

1. Open the List Column Section menu, and click Fields.
   
   The list column fields page appears.

2. Click New.
   
   The create page appears.

3. Select Time Scaled Value, and click Save and Continue.
   
   The column settings page appears.

4. Complete the following fields in the General section:

   **Value Attributes**
   
   Indicates the time-scaled values that are to display in the virtual column. In the Available list box, select the attributes you want to list in the column and use the arrow buttons to move the attributes to the Selected list box.

   **Column Label**
   
   Defines the name that appears at the top of the list column.

   **Display Type**
   
   Specifies how the time-scaled value is to display: as a number, a column graph, or a bar graph.

   **Secondary Value**
   
   Specifies an additional (second) value for a time-scaled value virtual column that displays as a tooltip when you mouse over the value in the column.

   **Link**
   
   Specifies a page link that appears as a secondary value that the user can select.

   **Open as Pop-up**
   
   Indicates whether the page appears as a pop-up. Select the check box to have the page appear as a pop-up.

   **Show Legend Label**
   
   Indicates whether the field label appears next to the time-scaled value in the virtual column. Select the check box to display the field label.

   **Show Column Label**
   
   Indicates whether the column label appears at the top of the column list. Select the check box to have the column label appear.
5. Complete the following fields in the Time Scale section:

**Start Date**

Indicates the start date for time period for the virtual-scaled value.

**Values:**

- **Specific Date.** Click the Datepicker icon to select a date.
- **Rolling Date.** Click the down arrow to select a relative date.
- **Other Date.** This option appears only if you are selecting a start date for a time-scaled value for a subobject. This field allows you to select a field from the master object on which to base the start date. This option only appears when a subobject has time-scaled value attributes.

**Time Scale**

Specifies the length of time the time-scaled value covers.

**Values:**

- **Specific Time Scale.** Indicates by naming a specific length of time what the period for the time-scaled value is. Click the down arrow to select a specific period of time.
- **Other Time Scale.** This option appears only if you are selecting a time scale for a time-scaled value for a subobject. The field lets you select a field from the master object on which to base the time scale.

**Number of Time Periods**

Defines the number of time periods that will be reported in the virtual column.

**Time Period Offset**

Defines the number of time periods you want to shift the beginning of the time-scaled value relative to the Start Date. You must enter a Start Date value to use this option.

**Show Group Row Header**

Specifies a timescale is to be displayed above the virtual column. Select the check box to display a timescale and select the period type you want from the drop-down list.

6. Complete the following fields in the Display section:

**Decimal Places**

 Defines the number of decimal places for data to be returned by the attribute. Enter a zero (0) to make the attribute an integer.

**Alignment**

 Specifies the text alignment in grid cells.
Allow Word Wrapping in Column Header
Indicates whether the text in the column label can wrap within the column. Select the check box to allow wrapping.

Allow Word Wrapping in Column
Indicates whether the text in the column can wrap within the column. Select the check box to allow wrapping.

7. Save the changes.

Add an Aggregation Row for a Number Field to a List Portlet
An aggregation row shows statistical data for money or number fields that display in the aggregation row. You can choose from a number of mathematical functions to apply to the individual fields you select for the row. You can choose maximum, minimum, average, sum, count, standard deviation, and variance.

Follow these steps:
1. Open the List Column Section menu, and click Aggregation.
   The list aggregation page appears.
2. Click Add.
   The properties page appears.
3. Complete the following fields:
   Label
   Defines the name for the aggregation row. Enter the name you want to appear.
   Show
   Determines whether the name of the aggregation row is displayed. Select the check box to display the name.
   Attribute
   Specifies the field value that is to be used for aggregation. All fields that you have selected for the grid portlet are present for selection but do not have to be included in the aggregation row.
   Function
   Specifies the aggregation function used to calculate values for a selected field (cell) in the row.
4. Save the changes.
Display an Aggregation Field as a Bar or Column Graph

You can display a field in an aggregation row as a number, a bar graph or a column graph. By default, the field displays as a number when it is first added to the aggregation row. The following procedure describes how to display an aggregation field as a bar or column graph.

This procedure assumes that the aggregation row with number fields has been created.

**Follow these steps:**

1. Open the List Column Section menu, and click Aggregation.
   
   The list aggregation page appears.

2. In the Display row, click the word that appears below the column whose display you want to change.
   
   The display page appears.

3. Select the display type, and click Save and Continue.
   
   If you select bar or column graph, these words appear at the bottom of the column in the Display row.

4. To complete the setup for a bar or column graph, click Bar Graph or Column Graph in the Display Row to complete the additional fields

5. Complete the following fields in the Primary Column section:
   
   **Thickness**
   
   Specifies the thickness of the column.
   
   **Values:**
   
   - Autofit
   - Narrow
   - Medium
   - Wide

   **Maximum Length**
   
   Defines the maximum length that the graph can be as a column or bar in pixels.

   **Length Scaling**
   
   Specifies what will be used as the basis for scaling if you want the graph scaled.

   **Color**
   
   Specifies the color for the graph.

   **Threshold Line Attribute**
   
   Specifies the field that is to be used to calculate a threshold for the graph.
Threshold Aggregation Function

Specifies the mathematical function used to calculate a threshold for the graph.

Over-threshold Color

Specifies the graph color used to indicate when the threshold has been exceeded.

6. To stack a second aggregation field value in the column of the list portlet, complete the following fields in the Stacked Column section:

Stacked Attribute

Specifies the second field value to be displayed as a bar or column graph in a column.

Color

Specifies the color for the graph.

7. Save the changes.

How to Configure a Chart

You can complete the following tasks to personalize a chart portlet:

- Open the configuration options (see page 29).
- Set a chart data source (see page 46).
- Determine a chart appearance (see page 46).
- Configure consistent chart colors (see page 45)
- Apply or remove consistent chart colors (see page 51)

Configure for Consistent Chart Colors

If your administrator selects the Use Consistent Chart Colors option at the system level, you can configure a chart portlet to do the following:

- Use consistent colors
- Use a consistent color key when assigning colors to a chart portlet. If you select a key, the color palette (out-of-the-box or custom) assigns colors based on the key.

Follow these steps:

1. Open a page containing the chart to modify.
2. Open the Options menu and click Configure.

The configure options page appears.
3. Complete the following fields:

   **Consistent Color Key**
   - Specifies the consistent color key. The list of available keys depends on the source data of the specific chart.

   **Use Consistent Colors Select**
   - Specifies overriding the selection (for this chart only) at the system level.
   - **Values:** Yes or No

4. Save the changes.

**Determine a Chart Portlet’s Source Data**

This procedure explains how to determine which data displays on a chart.

**To determine which data to display for a chart**

1. With the portlet open, click Chart Section and go to Source Data.
   - The source data page appears.
2. Select the metrics you want included in the chart.
3. Save your changes.

**Determine a Chart Portlet’s Appearance**

The following procedure explains how to determine the appearance of a chart. This procedure assumes the basic chart has been created and the data that the chart is to show has been chosen.

This procedure explains the basic procedure for all charts. All fields that might occur for any chart type are included but are marked by the type of chart to which the fields apply.

**To determine a chart portlet’s appearance**

1. With the portlet open, click Chart Section and go to Options.
   - The options page appears.
2. In the Options field, specify the part of the chart for which you are setting options.
3. Depending on the type of chart selected, complete the following display options and save your changes.

**Note:** The options are entered in alphabetic order rather than the order they appear on the page.

**Allow Configuration**
Indicates that a user can make changes to the appearance of a portlet. Select the check box to allow configuration.

**Allow Label Configuration**
Indicates that a user can make changes to portlet labels. Select the check box to allow configuration.

**Angle of First Slice**
Defines the position of the first dividing line. Use with Pie and Funnel charts.

Values: 0 to 360 degrees
Default: 0

**Axis Label**
Displays the metric name along the X-axis, Y-axis, or both axes. Use this option with:
- Bar. X-axis, Y-axis.
- Column. X-axis, Y-axis.
- Line. X-axis, Y-axis.
- Bubble and Scatter. X-axis.

**Crosses Opposite Axis At**
Defines the intersection point of the axis. Use with bubble and scatter charts.

**Category Labels**
Specifies for the X-axis of column and line graphs and the Y-axis of bar graphs the labels that appear along the category axis. For example, if a column graph shows five months of data with three metrics (shown as red, green and blue bars), the months are the categories and this field determines the label that appears on each one.

**Datapoint Labels**
Specifies the data name to be applied next to the value on the chart. Use this option with all data types.
Decimal Places
Defines the number of decimal places to display for numbers. Use this option with:

- Bar. X-axis.
- Column. Y-axis.
- Bubble and Scatter. X-axis, Y-axis.

Display Units
Specifies how values are rounded up. Select a value for rounding from the drop-down list. Use this option with:

- Bar. X-axis.
- Column. Y-axis.
- Bubble and Scatter. X-axis, Y-axis.

Filter
Indicates how the results appear initially.

Values:

- Automatically show results. Indicates you want immediate results.
- Do not show results until I filter. Indicates you want results provided after you filter.

Default: Automatically show results

Link
Specifies a page link that appears as a secondary value that the user can select.

Major Unit Increment
Defines the interval of major ticks on the axis. Use this option with:

- Bar. X-axis.
- Column. Y-axis.
- Bubble and Scatter. X-axis, Y-axis.
Maximum Value
Defines the greatest value to display on the axis. Use this option with:
- Bar. X-axis.
- Column. Y-axis.
- Bubble and Scatter. X-axis, Y-axis.

Mouseover Labels
Specifies the data values to show when a user moves the cursor over a chart value. Use with all chart types.

Other Category Threshold
Defines the data point at which all records for a specified value are grouped into a category named Other. Use this option if too many items appear on the chart. Use this option with the following chart types:
- Bar
- Column
- Line
- Pie and Funnel

Show Axis
Indicates whether the Axis line displays. Use this option with:
- Bar. X-axis, Y-axis.
- Column. X-axis, Y-axis.
- Line. X-axis, Y-axis.
- Bubble and Scatter. X-axis, Y-axis.

Show Legend
Specifies whether to display a legend for the chart. Use with bar, column, line, bubble, and scatter chart types.
Default: Selected

Show Line Markers
Indicates data points on the chart; otherwise, only a line displays. Available for line charts. Select the check box to show line markers.

Show Lines
Indicates that lines are to connect the data points. Available for line charts. Select the check box to show lines.
Show Major Grid Lines
Indicates whether major grid lines display on the chart. Use this option with:
- Bar. X-axis, Y-axis.
- Column. X-axis, Y-axis.
- Line. X-axis, Y-axis.
- Bubble and Scatter. X-axis, Y-axis.

Show Separator
Specifies that a comma is to separate values greater than 999 (for example, 1,000). Use this option with:
- Bar. X-axis.
- Column. Y-axis.
- Bubble and Scatter. X-axis, Y-axis.

Show Tick Labels
Indicates whether tick labels display on the chart. Use this option with:
- Bar. X-axis, Y-axis.
- Column. X-axis, Y-axis.
- Line. X-axis, Y-axis.
- Bubble and Scatter. X-axis, Y-axis.

Show Title
Indicates that the portlet name is to display. Available for all chart types. Select the check box to show the portlet name.

Sort Column
Indicates a column is to be the default sort item. This option is available for column and line charts.

Sub-type
Indicates the metrics are to display as separate bars rather than a single merged bar. Select the sub-type that is desired. This option is available for bar and column charts.
Tick Label Angle

Sets the angle of a label used with tick marks. Use this option with:

- Bar. X-axis.
- Column. X-axis.
- Line. X-axis.
- Bubble and Scatter. X-axis.

4. (Optional) If you are configuring a line chart, select Guides in the Options field and click New, then complete the following fields and save your changes:

**Axis**

Specifies the axis for which guides are being set.

**Label**

Defines the name for the axis. Enter the name you want to appear.

**Show Label**

Determines whether the name of the axis displays. Select the check box to display the name.

**Type**

Identifies the source of the information that displays on the guide. Select the appropriate option. If you are selecting a type for an X-axis, you can only select an attribute. If you are selecting a type for a Y-axis, select either the fixed value or the percent value and enter the amount.

**Values:** Fixed Value, Percent Value, or Attribute

**Default:** Attribute

**Color**

Specifies the color for the guide.

**Default:** Black

### Apply or Remove Consistent Chart Colors

CA Clarity PPM administrator can enable the Use Consistent Chart Colors option at the system level. In this case, you can switch between applying and not applying consistent colors at the chart level. The ability gives you flexibility when the colors assigned to the chart make it unreadable. For example, more than one data set displays the same color. Toggling between states of color is useful when charts with multiple metrics are used and the legend displays only one color.
If consistent colors are currently applied to a chart, you can switch to the Default Colors (that is, inconsistent colors) option. Conversely, if you do not apply consistent colors to a chart, you can switch to the Consistent Colors option in the Options menu.

The changes you make at a chart portlet level during a CA Clarity PPM session are only available in that session. Once you log out, the changes are lost. For the changes to be available outside a session, configure the chart portlet.

**Follow these steps:**
1. Open a page containing the chart to modify.
2. Select Consistent Colors or Default Colors from the Options toolbar for the chart portlet.
   
   The option that is available depends on the current chart setting (Default or Consistent).

---

### How to Configure a Filter Portlet

Use the following procedures to personalize a filter portlet:

- [Open the configuration options](#) (see page 29).
- [Add a field to a filter portlet](#) (see page 52).
- [Add a lookup or multi-valued lookup field to a filter portlet](#) (see page 54).
- [Lay out fields on a filter portlet](#) (see page 56).

### Add a Field to a Filter Portlet

**To add a field to filter portlet**

1. With the filter portlet open, click Fields.
   
   The fields page appears.

2. Click Add.
   
   The properties page for a field appears.

3. Complete the following fields. The fields can vary depending on the data type selected. You may not see all of the fields listed.

   **Field Name**
   
   Defines the field name you want to appear in the filter portlet.

   **Field ID**
   
   Defines a unique alphanumeric identifier for the field.
Description
Defines the purpose of the field and provides any relevant information.

Data Type
Specifies the data type for the field.

Display Type
Specifies how the field is to be used by the user.
Values: Browse, Text Entry, Numeric Range, Pull-Down, Date, or Date Range.

Show as Percent
Indicates if the value entered in the field should be shown as a percent. Select the check box to show the value as a percentage.

Filter Default
Specifies the value that appears in the filter field as the default value. If the filter portlet associated with this field is published to a dashboard as the filter default, this value will be applied to the portlet attributes mapped to this field.

Width
Defines the width of the field. If you leave the field blank, the field receives the default, which is 30 pixels. The default for date fields is 20 pixels.

Required in Filter
Specifies that a value is required in the field when a filter request is executed. If you select this check box, you must enter a value in the Filter Default field.

Hidden in Filter
Specifies that the field does not display in the filter at runtime, but the default value of the field is included when a filter request is executed. Select the check box to hide the field in the filter. If you select this field, you must provide a value in the Default Filter field.

Read-Only in Filter
Specifies that the field displays with a default value that cannot be edited by a user. Select the check box to make the field read-only in the filter. If you select this field, you must provide a value in the Default Filter field.

Hint
Defines a short message that helps a user use the field.
Limits: 512 characters

Tooltip
Provides a short message that displays when the user moves a cursor over the field.
4. Click Save and Continue.

Add a Lookup or Multi-valued Lookup Field to a Filter Portlet

Use the following procedures to add a lookup or multi-valued lookup field to a filter portlet. Lookup fields display a drop-down or browse list from which users can select items.

To add a lookup or multi-valued lookup field to a filter portlet

1. With the filter portlet open, click Fields.
   The fields list page appears.
2. Click Add.
   The properties page for a field appears.
3. Complete the following fields:
   - **Field Name**
     Defines the field name you want to appear in the filter portlet.
   - **Field ID**
     Defines a unique alphanumeric identifier for the field.
   - **Description**
     Defines the purpose of the field and provides any relevant information.
   - **Data Type**
     Specifies the data type for the field.
   - **Display Type**
     Specifies how the field is to be used by to the user.
     - **Values:** Browse, Text Entry, Numeric Range, Pull-Down, Date, or Date Range.
   - **Lookup**
     Specifies a list of lookup values that appears in the field for the user to select.
     The user views the list according to the display type selected.
4. Click Save.
   The fields on the page change to reflect the lookup you select and its data source (static or dynamic). Some of the fields listed in this section may not show on your page.
   - **Lookup Style**
     Indicates how many items a user can select for the field when the lookup is executed.
Entry

(Static dependent lookup lists only). Defines the starting point for the data a user sees listed in the lookup field. Select a level in the Level field or select a parent lookup value.

Exit

(Static dependent lookup lists only). Defines the end point of the data a user sees listed in the lookup field.

Filter Default

Specifies the value that appears in the filter field as the default value. If the filter portlet associated with this field is published to a dashboard as the filter default, this value will be applied to the portlet attributes mapped to this field.

Required in Filter

Specifies that a value is required in the field when a filter request is executed. If you select this check box, you must enter a value in the Filter Default field.

Hidden in Filter

Specifies that the field does not display in the filter at runtime, but the default value of the field is included when a filter request is executed. Select the check box to hide the field in the filter. If you select this field, you must provide a value in the Default Filter field.

Read-Only in Filter

Specifies that the field displays with a default value that cannot be edited by a user. Select the check box to make the field read-only in the filter. If you select this field, you must provide a value in the Default Filter field.

Hint

Defines a short message that helps a user use the field.

Limits: 512 characters

Tooltip

Provides a short message that displays when the user moves a cursor over the field.

5. If you selected a parameterized lookup in the Lookup field, complete the mappings in the Lookup Parameter Mappings section. This section is visible only for parameterized lookups.

See the Administration Guide for more information.

6. Click Save and Continue.
Lay Out Fields on a Filter Portlet

Use this procedure after you have created the filter portlet and its fields to determine the placement of the fields within the filter portlet when it is rendered on a portlet page.

The displayed list order of fields is how the fields appear in the Section view on a portlet page. If the Toolbar view is selected for the filter portlet, the fields display in a different order. The left column is equivalent to the top row and the right column is equivalent to the bottom row on the portlet. The left and right columns represent where the fields display on the portlet page.

To determine the layout fields on a filter portlet

1. With the filter portlet open, click Layout.
   The layout page appears.

2. In the Layout section, move the filter fields to the appropriate column list box by highlighting the fields and clicking the appropriate arrow buttons.
   You can change the order of the fields in the list boxes by highlighting a field and clicking the up and down arrows to move it in the list.

3. Complete the following fields in the Settings section:
   **Render As**
   Indicates how you want the filter portlet to appear on the published page or dashboard. Select Toolbar or Section. If you select Toolbar, the default filter state is fixed as Expanded.

   **Default Filter State**
   Indicates whether the filter portlet is to display on the dashboard as expanded or collapsed.

4. Click Save.
Appendix A: Access Rights

This section contains the following topics:

Timesheets Access Rights (see page 57)
Dashboard Access Rights (see page 57)
Page Access Rights (see page 58)

Timesheets Access Rights

The following access rights are available for timesheets:

Timesheets - Navigate

Lets you navigate to timesheet pages.
Type: Global

Timesheets - Edit All

Allows users to edit all timesheets.
Type: Global

Timesheets - Approve All

Allows users to approve all submitted timesheets.
Type: Global

Resource - Enter Time

Allows users to complete and submit timesheets for a specific resource.
Type: Instance

Project - Edit Project Plan

Allows users to add unplanned tasks to a specific project when completing their timesheets when they are a team member on the project.
Type: Instance

Dashboard Access Rights

The following access rights are available for dashboards:

Dashboard - Create

Allows users to create new dashboards from CA Clarity PPM.
Type: Global
Dashboard - Navigate

Allows users to navigate to any dashboard page in CA Clarity PPM.

Type: Global

Page Access Rights

The following access rights are available for pages:

Page - View

Allows users to view a general page in CA Clarity PPM. For instance pages (such as portfolio pages), this right is not required.

Type: Instance

Page Definition Editor

Allows users to edit, view, and delete the definition of a specific page.

Required: Administration - Studio access right to access the CA Clarity Studio menu.

Type: Instance

Page Definition Editor - All

Allows users to edit, view, and delete the definition of all pages.

Required: Administration - Studio access right to access the CA Clarity Studio menu.

Type: Global

Page Definition Viewer

Allows the user to view the definition of a specific page.

Required: Administration - Studio access right to access the CA Clarity Studio menu.

Type: Instance

Page Definition Viewer - All

Allows the user to view the definition of all pages.

Required: Administration - Studio access right to access the CA Clarity Studio menu.

Type: Global

Page Viewer - All

Lets the user view any configured portlet page. Before the users can view them, link the portlet pages to a menu. The user requires the rights to navigate the menu. For example, if a page links to the Administration menu, the users require the Administration - Access right.

Type: Global